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Document Supports: da Vinci 9.2 and higher

This document will guide the installer through the process of installing, configuring, and adding a Savant SHR-S2/2000 Host to a RacePoint Blueprint™ 
configuration. 

 – S2 Host Rack Mountable [SHR-S2-xx]
 – Smart Host Rack Mountable [SHR-2000-xx]
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Important Safety Information - Read First
Before installing, configuring, or operating any equipment, Savant recommends 
that each dealer, integrator, installer, etc. access and read all relevant technical 
documentation. Savant technical documentation can be located by visiting 
Savant.com. Vendor documentation is supplied with the equipment.
Read and understand all safety instructions, cautions, and warnings in this 
document and the labels on the equipment.

Safety Statements
All safety instructions below must be read, understood, and carefully followed 
under all applicable circumstances when working with any Savant equipment. 
1. Follow all input power ratings marked on product near power input!
2. If fuse replacement is required, replacement fuse should match fuse 

rating marked on the product.
3. Do not use equipment near water.
4. Clean only with dry cloth.
5. Do not block any ventilation openings or install near any heat sources 

such as heat registers, stoves, radiators, amplifiers, etc.
6. Refer all servicing to qualified service personnel.  Servicing is required 

when any part of the apparatus has been damaged in any way, or fails to 
operate normally for any reason.

7. Use only attachments/accessories specified by the manufacturer, 
following all relevant safety precautions for any such attachments/
accessories.

8. For applicable equipment, use the included power cord with the 
grounding prong intact to insure proper grounding of the device. 

9. If the provided plug does not fit the desired outlet, contact a licensed 
electrician to replace the obsolete outlet. 

10. Protect any power cord from being walked on, pinched, strained, or 
otherwise potentially damaged, especially at the outlet or device 
connections.

11. Disconnect any outlet powered apparatus from its power source during 
lightning storms or when unused for long periods of time.

12. To completely disconnect equipment from AC mains power,  disconnect 
the power supply cord plug from the AC receptacle on the device.

13. For any hardwired or fixed in-wall apparatus, carefully follow all wiring 
diagrams and instructions.  All electrical wiring and servicing should be 
performed by a properly licensed electrician. 

Safety Classifications In this Document

NOTE: Provides special information for installing, 
configuring, and operating the equipment.

 IMPORTANT!
Provides special information that is critical to 
installing, configuring, and operating the equipment.

 CAUTION!
Provides special information for avoiding situations 
that may cause damage to equipment.

 WARNING!

Provides special information for avoiding situations 
that may cause physical danger to the installer, end 
user, etc.

Electric Shock Prevention

 ELECTRIC 
SHOCK!

The source power poses an electric shock hazard 
that has the potential to cause serious injury to 
installers and end users.

 ELECTRICAL 
DISCONNECT:

The source power outlet and power supply input 
power sockets should be easily accessible to 
disconnect power in the event of an electrical hazard 
or malfunction.

Weight Injury Prevention

 WEIGHT INJURY!

Installing some Savant equipment requires two 
installers to ensure safe handling during installation. 
Failure to use two installers may result in injury.
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1. Before You Begin
Read this document in its entirety before starting deployment of the product, and ensure that the following required items are available:

Savant Rack Mountable Host Unique ID (UID) and MAC Address ..................................................................................................................................  
SHR-S2 or SHR-2000

da Vinci Runtime for Host upgrade .............................................................................................................................................................................................  
See table below for minimum supported release.

Smart Standard License 9.0 or higher .......................................................................................................................................................................................  
(SHR-S2 license is pre-installed) 

Savant Development Environment (SDE/MacBook®) ..........................................................................................................................................................  
See table below for minimum supported version.

Ethernet network meeting Savant requirements ...................................................................................................................................................................  
See Appendix A: Network Requirements

Device Features and Zones Supported by Savant Hosts ....................................................................................................................................................  
Refer to the Host Licensing and Feature Support Matrix located on the Savant Customer Community for a list of the available features before starting 
Blueprint configuration.

Supported Releases

Device Minimum Supported Release
SHR-S2-00 da Vinci 9.1.3

SHR-S2-01 da Vinci 9.3.6

SHR-2000-xx da Vinci 9.2

https://community.savant.com/Customers/SavSupportLogin
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2. Deployment Steps
To successfully deploy a Savant Rack Mountable Host, follow the steps listed below. This page can be used as a checklist to track progress as items are 
completed.

Review product specifications and connection details .......................................................................................................................................................  
See the device’s Quick Reference Guide on the Savant Customer Community.

Install the Savant Host ......................................................................................................................................................................................................................  
See Installation

Update the Savant Host to the latest version of da Vinci ...................................................................................................................................................  
See the Savant Host Runtime Upgrade Deployment Guide [da Vinci 9.x] on the Savant Customer Community for steps to upgrade the Savant Host.

Add the Host to a RacePoint Blueprint® configuration ........................................................................................................................................................

Install an OS Runtime License on the Host ..............................................................................................................................................................................  
Refer to the Savant Runtime Operating System Licensing Application Note on the Savant Customer Community.

https://community.savant.com/Customers/SavSupportLogin
https://community.savant.com/Customers/SavSupportLogin
https://community.savant.com/Customers/SavSupportLogin
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3. Installation
The Savant Host can be installed in a standard National Electrical Manufacturer’s Association (NEMA) rack, or on a solid, flat, level surface such as a table, 
cabinet, or shelf. The location should be dry, well ventilated, and out of direct sunlight.

3.1. Mounting Plate
A mounting plate (074-0577-xx) is supplied with the SHR-S2. This 
mounting plate is used to mount the Host to a wall or existing 
structure. To mount the Host, follow the instructions below.
1. Position the mounting plate onto the wall where the Host will 

be located. Position the bracket so the tabs that hold the Host 
are positioned horizontally.

2. Mark the two mounting holes on the wall.
3. Install wall anchors and screw mounting plate to the wall.
4. Snap the SHR-S2 Host into the bracket so the tabs on the 

mounting bracket seat into the slots on the side of the Host. 

Host

Mounting
Bracket

Tab fits 

into slot

 

3.2. Rack Mount
The SHR-S2 can use the optional RCK-3000-xx provides a 
ventilated shelf for mounting S2 Hosts. This rack is compatible with 
all standard 19-inch National Electrical Manufacturers Association 
(NEMA) rack mounts.
The SHR-2000 can use the optional RMB-PAVAM2F-xx or RMB-
PAVAM2-xx allows two devices to be mounted side by side. For 
example a Smart Host can be mounted next to a PAV-AIM7C. This 
rack is compatible with all standard 19-inch National Electrical 
Manufacturers Association (NEMA) rack mounts.
The instructions below show the RMB-PAVAM2F-xx, both brackets 
install the same way they just face different directions.
1. Align the bracket with the Smart Host mounting points.
2. Attach using the screws provided with the bracket. 
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4. Wiring and Connections

4.1. Power
Savant Hosts use an A/C power connection.  Read and adhere to the warnings listed below:

 SURGE PROTECTION! 
Use a surge-protected circuit for all components and power supplies requiring 100/240V (AC 50/60 Hz) source power.

 ELECTRICAL DISCONNECT! 
The source power outlet and power supply input power sockets should be easily accessible, to disconnect power in the event of an electrical 
hazard or malfunction.

Power Management Recommendations
Savant recommends a pure sine wave uninterruptible power supply (UPS) with the ability to gracefully shut down the Savant Host before the battery 
runs out of power. Never remove power from the Savant Host before shutting it down. See Appendix B: UPS Recommendations for more information.

4.2. Ethernet

Wired Connection
The Savant Host communicates with other devices on the network via a cat 5e/6/7 Ethernet connection.
For more information on using Ethernet, refer to Appendix A: Network Requirements.

Wireless Connection (SHR-S2 only)
The S2 Host contains a wireless radio. This device can use used with a wireless connection. Provisioning can be done with the Savant SmartConnect 
App. For more information see the SmartConnect Software Reference Guide on the Savant Customer Community.

4.3. Audio Output
Savant Hosts include a Digital Optical (TOSlink) audio output for use with the Audio Interrupt Service (AIS). Connection instructions may vary based 
on the Savant Audio Matrix or 3rd party switcher in use.  For more information on configuring an AIS service, refer to the Audio Interrupt Service 
(AIS) Configuration for Doorbells - Application Note, available on the Savant Customer Community

https://community.savant.com/Customers/SavSupportLogin
https://community.savant.com/Customers/SavSupportLogin
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4.4. Control Connections
The Savant Host control connections send data to control a device and receive data to display current status on the user interfaces or trigger a 
system action. Each port type may support multiple protocols that are determined by the logical connection within Blueprint.

 TIPS:
 – Savant recommends that installers plan all control connections and protocols to be used on site prior to any physical configuration or cable 

construction. This helps to ensure that devices respond effectively to control commands and are not damaged by incorrect cable configuration.
 – When installing wire in screw down terminals, strip a 1/4 inch of insulation from each wire and twist the strands together. This will allow for the 

exposed wire to be inserted into the terminal up to the insulation, eliminating stray strands that may cause shorting.

RS-232 Wiring

Pinout

RJ-45 Connector
(Gold pins facing up)

Pin 1 Pin 8 Pin 1: No Connection NOTES:
 – CTS/RTS handshaking is supported for flow control based on the profile used in 

the configuration.
 – Wire coloring is included to identify the pins used for this connection. Colors 

shown do not represent any wiring standard.
 – The SHR-S2/2000 Hosts does not support RS-422/485.

Pin 2: No Connection

Pin 3: No Connection

Pin 4: GND (Ground)

Pin 5: RXD (Receive)

Pin 6: TXD (Transmit)

Pin 7: CTS (Flow Control)

Pin 8: RTS (Flow Control)

 IMPORTANT! When wiring to this port, DO NOT connect any wires within the cable that are not required for communication.

RJ-45 to DB9 Serial Control Adapters
Refer to the RS-232 Conversion to DB-9 and RS-422/485 Pinout Reference Guide located on the Savant Customer Community for more information 
on RJ-45 to DB9 adapters.

 IMPORTANT! When using RJ-45 to DB9 adapters not supplied by Savant:
 – Ensure that any wires required for communication/control are terminated within the adapter.
 – Ensure that all wires NOT required for communication/control are NOT terminated in the connector.
 – Ensure that the unused wires in the connector are cut to prevent them from shorting out, as they are still terminated in the RJ-45 connector on 

the controller side.

https://community.savant.com/Customers/SavSupportLogin
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IR Wiring
IR connections are made using 6-pin Screw Down Plug-in Connectors supplied with the Host. The wire slips into the hole and locks with a screw 
located at the top of the connector.

Pinout

1

IR1
+- +- +-

2

IR2

3

IR3

4 5 6

Use White Stripe 
for Positive (+)

Pin 1: IR 1 -

Pin 2: IR 1 +

Pin 3: IR 2 -

Pin 4: IR 2 +

Pin 5: IR 3 -

Pin 6: IR 3 +

 IMPORTANT! IR Wiring Precautions
 – Ensure that all IR emitters are within 15 feet (4.6 meters) of the controller’s location.
 – Use of 3rd party flashing IR emitters with Talk Back is not recommended. These types of emitters can draw voltage away from the IR signal, 

resulting in degraded IR performance.

Relay Wiring
Relay ports are used when a device is controlled via a normally open (NO) or normally closed (NC) relay.

Pinout

321

NC NOC/ / Pin 1: NC (Normally Closed)

Pin 2: C (Common)

Pin 3: NO (Normally Open)
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GPIO Wiring
General Purpose Input/Outputs (GPIO) are binary I/O ports used on Savant controllers to trigger an action within the system. Events can control 
a device, such as turning on an amplifier (output) or detecting a state change for a device (input) to perform a workflow. Pin 1 is used for input or 
output depending on the Component Profile used within the Blueprint configuration.

Pinout

321

GPIO 1
Standard

GPIO Using
PD Jumper

Gnd I/O PD

Pin 1: GND (Ground)

Pin 2: O/I (GPIO 1)

Pin 3: PD (Pull Down Resistor)

GPIO Pull Down Resistor (PD) Usage
GPIO pins configured as inputs are pulled high to 12V while the Host is booting up. To make the GPIO signal low (< 0.8V) during a Host reboot and/or 
a power cycle, attach the GPIO 1 pin to the PD pin. The PD pin is a 1K ohm pull down resistor (to signal ground) which keeps the GPIO output below 
0.8V during processor boot times. See item I under Rear Panel for GPIO voltage ratings.



S2/2000 Deployment Guide  |  009-1914-03 220204  |  Copyright © 2021 Savant Systems, Inc. 
11     of     25

5. Blueprint Configuration
The Savant Host type defined within the RacePoint Blueprint > Preferences menu is automatically added to the Component List under a Shared 
EquipmentZone (for more details, refer to Preferences: RacePoint Blueprint Programming Guide on the Savant Community Knowledge Base). If the default 
Host type defined in the Preferences settings does not match the model of Host in use at the site, the next section provides steps for replacing the Host 
profile.

 IMPORTANT NOTES! 

 – S2/2000 Hosts cannot be used as a subordinate or controller, and should only be configured as the System Host when added to a configuration.
 – While the default Host profile is automatically added to the Component List, the Host should also be placed within the Layout frame, and a control 

connection to a Network Device should be represented.  This is recommended as a general best practice, and is required for generation of Host-based 
services such as lighting, fan, and general programmable service requests.

Required Devices

 – SHR-S2 or SHR-2000 Host

Optional Devices
 – IR Controllable Devices
 – Serial (RS-232) Controllable Devices
 – Contact Closure (Relay) Controllable Devices
 – Voltage Trigger (GPIO) Controllable Devices
 – IP (Ethernet) Controllable Devices
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5.1. Replacing a Host in a Configuration
In cases where the default Host type (defined under RacePoint Blueprint > Preferences > General) does not match the Host model used on site, the 
Host Profile must be replaced; as in the example shown below, where a default Pro Host is replaced with the SHR-2000.

1. In an open Blueprint configuration, open the Component 
Library by navigating to: View > Show Component Library 

2. Enter SHR-2000 into the Search field. 

3. Select the SHR-2000 profile from the list and drag it onto the 
Host in the left side Component List. 

4. Select Replace when prompted. 

5. At the top of the Component List, select the Host and drag it 
into the Layout Window. 

6. Select the Host profile. 

7. Open Inspector. 

8. Enter a Device Name for the Host.  

9. Enter Savant UID for the Host. 

 TIPS:
 – Savant recommends using the customer’s last name and a 

number unique to the customer followed by Host. 
Example: Dresden45 Host

 – Host names exceeding 20 characters, or utilizing special 
characters (such as &, %, @, #, etc.) may cause certain 
types of communication issues, and are therefore not 
recommended by Savant.

Savant  Host

Shared  Equipment

Room  1

Tool  Palette Layer  Filter License State Update  All  UI  ScreensSave Generate  Services

Components

All Components

All Manufacturers

SHR-2000

Components

Savant
Smart Rack Mount Host (SHR-2000)3

Inspecting “Savant  Host”

Data  I/Os

?

?

ScreensDevice Hide Details

S  1.3

Edit

Class:

Manufacturer:

Model:

Device Name:

Savant UID:

Notes:

Show:

Savant  Host

Savant

Smart Rack Mount Host

Dresden45  Host

9

8
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5.2. Adding a Host to the Layout Window
This section outlines the process for adding an SHR-2000 Host to the Layout Window from the Component List and configuring it as the System 
Host. The same steps apply when using the SHR-S2 Host type.
Follow the steps below: 

1. In an open Blueprint configuration, select the Host at the top 
of the Component List and drag it onto the Layout Window.

2. Enter a unique Device Name and the Savant UID for the Host. 
The Savant UID is used to identify the Host on the network so 
that a configuration may be uploaded. The UID can be found 
printed on a label on the physical Host on site.

3. Select the Host in the Layout Window and open the Inspector 
by navigating to: 
View > Show Inspector

4. Enter a Device Name that is unique to the system.
5. Enter the Savant UID for the Host. 

 TIPS:
 – Savant recommends using the customer’s last name and a 

number unique to the customer followed by Host. 
Example: Dresden45 Host

 – Host names exceeding 20 characters, or utilizing special 
characters (such as &, %, @, #, etc.) may cause certain 
types of communication issues, and are therefore not 
recommended by Savant.

Inspecting “Savant  Host”

Data  I/Os

?

?

ScreensDevice Hide Details

S  1.3

Edit

Class:

Manufacturer:

Model:

Device Name:

Savant UID:

Notes:

Show:

Savant  Host

Savant

Smart Rack Mount Host

Dresden45  Host

5

4

Savant  Host

Shared  Equipment

Room  1

Tool  Palette Layer  Filter License State Update  All  UI  ScreensSave Generate  Services

Savant Host

Control Ports
IR(Serial PWM)  Output  1
IR(Serial PWM)  Output  2
IR(Serial PWM)  Output  3
IR(Serial PWM)  Output  4
IR(Serial PWM)  Output  5
IR(Serial PWM)  Output  6
RS232-1  (RTS/CTS)
RS232-2  (RTS/CTS)
Relay  NO/NC  1
GPIO  1

Outputs

Data
TOSLink  (Digital  Optical)

Ethernet  (Ethernet)
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5.3. Adding a Doorbell or Door Station
The SHR-S2 AND SHR-2000 Hosts support the Audio Interrupt Service (AIS) which is used to interrupt the currently playing audio with a doorbell 
chime alerting the user that a doorbell has been pressed. This service requires a connection between the Smart Host and a Savant Audio Matrix or 
3rd party audio matrix.
Refer to the Audio Interrupt Service (AIS) Configuration for Doorbells Application Note located on the Savant Customer Community for information 
on using AIS.

5.4. Use of Custom Automator Workflows and Applescripting
 – Only Savant Automator actions, Apple’s Pause, or Run Shell Script actions can be used. All other actions will be ignored.

NOTE: Functions such as email can be programmed using the Run Shell Script action. 
See Setting Up Mail (Gmail Only) for Notifications for more information.

 – Applescripting is not supported on SHR-S2/2000 Hosts. Another scripting language and the Savant Command Line Interface Bridge (sclibridge) 
must be used. See Running Scripts for more details.

https://community.savant.com/Customers/SavSupportLogin
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6. Host Configuration
The Savant SHR-S2 and SHR-2000 Hosts do not offer a graphical user interface (GUI) for configuration.  The Terminal command line interface is used to 
communicate with and configure the Host via Secure Shell (SSH) commands when needed.  The section below outlines a number of commonly used SSH 
commands and their function as it relates to Host configuration.

NOTE: This section includes a number of SSH commands which can be input into Terminal or other command line applications. Copying and pasting 
command syntax directly from this document may result in formatting errors being introduced during the transfer.  Check all copied commands 
carefully to ensure their functionality. 

6.1. Change the Host User Password
For security purposes, especially with remote access for dealers, Savant is providing a command line utility to easily change the password of the 
Host.

NOTE: Savant recommends passwords be at least 10 characters long and include numbers, symbols, and capital letters.
1. Launch the Savant Application Manager (SAM).
2. Select the appropriate da Vinci release for the Host and click Activate.
3. Open System Monitor by selecting it from the right side menu.
4. In an open System Scanner window, select Savant Host.
5. Click Terminal in the menu bar to open a session with the selected Host.
6. In the open Terminal window type: 

savantSetPassword
7. When prompted, enter the current password
8. When prompted, enter the new password
9. Once the password has been changed, reboot the Host to ensure that the security changes are applied to all processes.

6.2. Setting Up Mail (Gmail Only) for Notifications
The SHR-S2 and SHR-2000 Hosts can be configured to send notifications via email or SMS text message using a custom workflow within RacePoint 
Blueprint.  For details on configuration, refer to the article titled How to Send an Email/SMS Text Notification from a Triggered Workflow - 
Programming Guide, available on the Savant Customer Community.

https://community.savant.com/Customers/SavSupportLogin
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6.3. Querying and Configuring DNS and IP Address
By default, the Host is set to pull its IP address from DHCP.  Changing to a static IP requires the user to access the Host via Terminal.

NOTE: DNS addressing can only be set manually for Hosts using a statically assigned IP address.  For Hosts set to DHCP, the local router’s DNS 
settings take precedence.

1. Launch the Savant Application Manager (SAM).
2. Select the appropriate da Vinci release for the Host and click Activate.
3. Open System Monitor by selecting it from the right side menu.
4. In an open System Scanner window, select the Savant Host. 

? Local Network

Dersden45Host Dersden45 Host

System NameDevice Name

Scanner
Connect Share Screen Mount Terminal View Logs Get Logs Get Config

4

5

5. Click Terminal in the menu bar to open a session to the selected Host.
6. When prompted, enter the password for the Host. 

Default: RPM
7. In the open Terminal window enter a command to perform from the list below: 

For help and supported 
argument list:

setIPAddress --help

Query the Current 
Address and Mode:

setIPAddress
Example of Terminal Window:
setIPAddress
> eth0: setup for DHCP
eth0  Link encap:Ethernet HWaddr ec:a8:6b:f6:8b:df 
 inet addr:10.0.100.155 Bcast:10.0.100.255 Mask:255.255.255.0 
 UP BROADCAST RUNNING MULTICAST MTU:1500 Metric:1 
 RX packets:314715 errors:0 dropped:0 overruns:0 frame:0 
 TX packets:33460 errors:0 dropped:0 overruns:0 carrier:0 
 collisions:0 txqueuelen:1000 
 RX bytes:113254559 (108.0 MiB) TX bytes:5705141 (5.4 MiB) 
 Interrupt:20 Memory:f7c00000-f7c20000

Set to DHCP:

setIPAddress –DHCP
A message will appear to confirm the requested change. After confirming (y), the 
connection to the Host will be lost as the IP address has changed. Close the Terminal 
window after confirming and entering password for Host RPM user.



S2/2000 Deployment Guide  |  009-1914-03 220204  |  Copyright © 2021 Savant Systems, Inc. 
17     of     25

Set to Static:

setIPAddress -static -address x.x.x.x -netmask x.x.x.x -gateway x.x.x.x
Substitute x.x.x.x with the appropriate addresses.
A message will appear to confirm the requested change. After confirming (y), the 
connection to the Host will be lost as the IP address has changed. Close the Terminal 
window after confirming and entering password for Host RPM user.

Add a DNS Server 
Address to the list:

setDNSServer -add -address x.x.x.x
Substitute x.x.x.x with the appropriate addresses.

Remove a DNS Server 
Address from the list:

setDNSServer -remove -address x.x.x.x
Substitute x.x.x.x with the appropriate addresses.

Query Current DNS 
Server Information:

setDNSServer
Example of Terminal Window:
> setDNSServer 
Current DNS Servers: 
   servername 8.8.8.8 
   servername 8.8.4.4
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7. Running Scripts
Custom workflows and scripts created within Blueprint are copied to the Host when the configuration is uploaded. However, scripts that are created 
outside of Blueprint using Automator or Linux will need to be copied to the Host for the system to access them. These items will need to be placed on the 
Host by using SSH commands.

NOTE: This section includes a number of SSH commands which can be input into Terminal or other command line applications. Copying and pasting 
command syntax directly from this document may result in formatting errors being introduced during the transfer.  Check all copied commands 
carefully to ensure their functionality.

 IMPORTANT! S2/2000 Hosts can only run scripts containing Savant Commands, located under Actions > Other within Automator. Scripts utilizing 
Applescript or other Mac commands should never be copied to S2/2000 Hosts, as they are not supported, will not function, and may render the 
system unresponsive.

7.1. Recalling Script Files
Scripts added via Blueprint using the Customer Files [bold] folder accessed through the Tools > Customer and Provider Info [bold menu path] dialog 
are stored in a different location within the Host filesystem for S2/2000 Host types than with a Savant Pro Host.
Refer to Tools Menu - Channel Listings Editor, Customer and Provider Information: RacePoint Blueprint Programming Guide located on the Savant 
Customer Community for details on adding Customer Files.

CancelCustomer Files... OK

Customer Files folder access in
Tools > Customer and Provider Info dialog.

Files that have been added to Customer Files are located under the following path on the Host:
 /home/RPM/GNUstep/Library/ApplicationSupport/RacePointMedia/userConfig.rpmConfig/CustomerFiles

https://community.savant.com/Customers/SavSupportLogin
https://community.savant.com/Customers/SavSupportLogin
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7.2. Executing Scripts on the Host
Custom scripts, workflows, and other programming can be executed on Savant Hosts using sclibridge, a command line utility used to interact directly 
with the Savant Host via Terminal for advanced customization.
When using an SHR-S2, SHR-2000, or other Linux-based Hosts, the sclibridge utility is located within the Host filesystem in the directory shown 
below: 
/usr/local/bin/sclibridge
This is different from the location of the utility for Savant Pro, Super Pro, or any other MacOS-based Host, and should be kept in mind when writing 
or testing any such scripts or workflows.
A standard UNIX utility can be used to determine the platform any script is running on, and adjust accordingly.  See example below for reference:

#!/usr/bin/perl -w

$osType = `uname`;
chomp($osType);

$sclibridge = undef;

if($osType eq "Linux OS")
{
    print "Running on Linux\n";
    $sclibridge = "/usr/local/bin/sclibridge";
}
elsif($osType eq "Mac OS")
{
    print "Running on Darwin\n";
    $sclibridge = "/Users/RPM/Applications/RacePointMedia/sclibridge";
}
else
{
    print "Running on Unknown: $sclibridge\n";
}
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8. Troubleshooting
The subsections below contain information related to software tools and processes which can be helpful for troubleshooting potential Host-related issues 
in the field.  For further troubleshooting assistance, check the Savant Customer Community Knowledge Base, or submit a case with Savant Support for 
direct technical assistance.

8.1. Retrieving Logs
When troubleshooting undesirable behavior in a deployed Savant system, retrieving logs from the Host can be particularly useful, especially in cases 
where the problem can be reproduced and an accurate timestamp can be provided to Savant Support.  Host logging contains a record of the actions, 
messages, service requests, state changes, and more processed by the Host.  Follow the steps below to retrieve Host logs:
1. Launch the Savant Application Manager (SAM) on the SDE, and click Activate next to the desired release if necessary.
2. Open System Monitor by selecting it in the right side menu.
3. Select the Savant Host in the list. 

? Local Network

Dersden45Host Dersden45 Host

System NameDevice Name

Scanner
Connect Share Screen Mount Terminal View Logs Get Logs Get Config

4

3

4. Click Get Logs on the top menu bar.
5. A dialog window with options for saving the log files will open, as shown in the example image below.
6. Save As: Select a name that identifies the file. 

Example: Dresden45Host_2019-12-25-102552_DiagnosticReports 

Clear Reports

Where:

Tags:

Save As: Dersden45Host_2019-12-25-102552_Diag

Downloads

Cancel Download

6

7

8

9

7. Select a location within the SDE filesystem to save the logs to.
8. Clear Reports: When checked, all reports on the Host will be cleared after saving the log file.
9. Click Download to transfer and save the report.
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8.2. Stopping and Starting the Host
Stopping and starting the runtime software can often be a useful step during troubleshooting.  This can be done via System Monitor, or through a 
Terminal command line session.

Restart Runtime via System Monitor Process Tab
1. Launch the Savant Application Manager (SAM).
2. Select the appropriate da Vinci release for the Host and click Activate.
3. Open System Monitor by selecting it in the right side menu.
4. In an open System Scanner window, select the Host.
5. Click Connect, or double-click the selected Host.
6. In an open System Dashboard window, select the Processes tab on the left.
7. In the Remote Management section, select Soft Reboot to restart the runtime software.

Stopping the Host via System Monitor Processes Tab

NOTE: Before stopping the Host using this method, write down the IP Address so that it can be restarted using the Command Line method below.
1. Launch the Savant Application Manager (SAM).
2. Select the appropriate da Vinci release for the Host and click Activate.
3. Open System Monitor by selecting it in the right side menu.
4. In an open System Scanner window, select the Host.
5. Click Connect, or double-click the selected Host.
6. In an open System Dashboard window, select the Processes tab on the left.
7. In the Remote Management section, select System Stop to stop the Host.

Stopping and Starting via Command Line
1. Launch the Savant Application Manager (SAM).
2. Select the appropriate da Vinci release for the Host and click Activate.
3. Open System Monitor by selecting it in the right side menu.
4. In an open System Scanner window, select the Host.
5. Click Terminal in the menu bar to open a session on the selected Host.
6. At the command prompt, type one of the following commands:

 – stopSavantSystem
 – startSavantSystem



S2/2000 Deployment Guide  |  009-1914-03 220204  |  Copyright © 2021 Savant Systems, Inc. 
22     of     25

8.3. Uploading Configuration to the Host
To upload a Blueprint configuration to a Savant Host, the recommended methods are to use either the Upload to Master button from the main 
Blueprint taskbar, or the Upload button in System Monitor.  If neither of these methods are available for any reason, configuration files can be 
uploaded to the Host via the command line following the steps listed below.
1. Launch the Savant Application Manager (SAM).
2. Select the appropriate da Vinci release for the Host and click Activate.
3. Open System Monitor by selecting it in the right side menu.
4. In an open System Scanner window, select the Savant Smart Host.
5. Click Upload to start the upload process.
6. Click Browse and then navigate to the SDE folder containing the configuration file to upload.
7. Select the configuration file in the folder and click Open.
8. In the open dialog showing the selected file, click Upload.

8.4. Copying the Configuration File to the SDE
The preferred method for downloading configurations to the SDE is using the Get Config button in System Monitor.
1. Launch the Savant Application Manager (SAM) on the SDE, and click Activate next to the desired release if necessary.
2. Open System Monitor by selecting it from the right side menu.
3. Select the Host from the list. 

? Local Network

Dersden45Host Dersden45 Host

System NameDevice Name

Scanner
Connect Share Screen Mount Terminal View Logs Get Logs Get Config

4

3

4. Click Get Config on the top menu bar.
5. A dialog window will open to save the configuration file that provides the following options:
6. Save As: Select a name that identifies the file. 

Example: SmartHost_2016-03-22-102552_config.tgz 

Where:

Tags:

Save As: Dersden45Host_2019-12-25-102553_conf

Downloads

Cancel Download

6

7

8

7. Where: Location to Save the configuration.
8. Download: Click to download the configuration.
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Appendix A: Network Requirements
Savant requires the use of business class/commercial grade networking equipment throughout the network to ensure the reliability of communication between 
devices. These higher quality components also allow for more effective troubleshooting when needed.

Device Network Connections
Connect all Savant devices to the same local area network (LAN) or subnet as the Host. Savant recommends the implementation of a flat network topology for 
all Savant devices.  Use of network utilities such as band steering, packet shaping, QoS, or fast roaming (802.11r), etc. may interfere with performance.

Managing IP Addresses
To ensure that IP addresses will not change due to a power outage, a static IP Address or DHCP reservation should be configured for the Savant Host and all 
other Savant or Savant-controlled devices. Savant recommends using DHCP reservation within the router. By using this method, static IP addresses for all devices 
can be managed from a single UI, avoiding the need to access devices individually.

Setting DHCP Reservation
Setting DHCP reservation varies from router to router. Refer to the documentation for the router to configure DHCP reservation.

Network Changes
Savant recommends performing the following steps to refresh the IP connection after connecting to a new network, changing routers, or if the IP Address range 
is changed in the current router. This will reset any IP connection and ensure that the Host is communicating with the network correctly.
 – Hot Plug the Ethernet (LAN) Connection

1. Disconnect the Ethernet (LAN) connection from the Host.
2. Wait 15 seconds and then reconnect.

Network Guidelines
See the Savant Device Networking Guidelines topic on the Savant Customer Community for networking recommendations.

https://community.savant.com/Customers/SavSupportLogin
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Appendix B: UPS Recommendations
Savant does not recommend any brand or model UPS, however there are a couple of factors that should be considered. It is important that the UPS does not 
only work during complete power loss but protects devices and their functionality during events like surges and brownouts. It is not uncommon for a residence 
or small business to see variations in power service that do not result in a complete black-out. These periods can be the most frustrating to end users as they do 
not realize what the cause of the operation disturbance may be.
Below are some specific design considerations when assembling your power management designs.
 – Pure Sine Wave Inverter.
 – Online/double-conversion power supply: This type of UPS always supplies power to the equipment this will eliminate any period where the power is 

interrupted. This will also address many issues if the site has regular “brown outs” or id the site has frequent under of over voltage situations.
 – Max power output: The UPS needs to be properly sized for the equipment connected to it, and unnecessary loads should not be included on the UPS. For 

instance, putting an audio amplifier on the UPS will either drive up the cost of the UPS system to support the load or drastically shorten the period that the 
UPS can keep devices up and running. 
Remember to consider devices that you may not have directly installed, for instance modems, routers, switches, APs, PoE injectors, and the like. This is 
especially important if you are using software that relies on the network for communication. Power cycling segments of the network can cause network 
conflicts. It is important to consider this during your network design and configuration to ensure that there is the greatest likelihood of success.

 – “Graceful” shut down: The UPS should communicate with the devices connected to it so that when necessary they are properly shut down. Many UPS 
manufacturers offer a software suite so that hard-drive based devices may go through a ‘graceful’ shut down procedure. This feature should be vetted in a 
test environment prior to implementation so that the integrator understands how the system will respond during shutdown and start-up periods.

 – Power consumption monitoring. 
It is nice to have the ability to monitor the draw from each outlet to determine if an item is running through a remote console.

 – Remote Access: The ability to remotely power cycle an outlet or a group of outlets.

 IMPORTANT! Be VERY CAUTIOUS using with a UPS with the ability to cycle power an outlet remotely, devices with hard drives DO NOT like to be power 
cycled in this manner, and will be damaged by this action. Savant Hosts in particular need to be shut down correctly in order to restart correctly when 
power is restored.

 – Generators: Generators are not a replacement for a UPS and should be considered as an augment to the UPS. Having a generator on site increases the need 
for a UPS because the equipment needs greater protection from power cycles when the generator comes online during testing. A generator is also likely to 
introduce electrical conditions like under and over voltage or frequency modulation while running. All of these circumstances stress power supplies and hard 
drives increasing the odds of premature failure.

Savant does have a variety of IP & Serial controlled UPS devices currently profiled (these can be found under Trigger Devices).
 – The UPS profiles are designed to give the integrator a set of variables and triggers to perform actions with. The Savant User Interface has no default 

screen(s) that will auto populate for any of these devices.
 – For feedback: All devices support a variety of different state information so make sure to put the device in an example configuration and check what states 

you can use as a trigger to make sure the profile supports the information you require. The easiest method to accomplish this is to add the desired device to 
a configuration, make the necessary control connection, generate services, create a new trigger (Tools->Review->State Triggers...), add a transition condition 
then select the UPS device under the component tab. This will show you all of the states that profile supports in the “State Name” table.

 – For Control: Since many devices have different configurations as to what outlets shut off together etc. Savant recommends that you use a CPT kit and test 
the control commands prior to install to verify it is possible to accomplish the automation task which is proposed.
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Important Notice

Disclaimer
Savant Systems, Inc. reserves the right to change product specifications without notice, therefore, the information presented herein shall not be construed 
as a commitment or warranty. 
Savant Systems, Inc. shall not be liable for any technical or editorial errors or omissions contained herein or for incidental or consequential damages 
resulting from the performance, furnishing, reliance on, or use of this material.

Patents
Certain equipment and software described in this document is protected by issued and pending U.S. and foreign patents.
All products and services are trademarks or registered trademarks of their respective manufacturer. 

Copyright
This document contains confidential and proprietary information protected by copyright. All rights reserved. Copying or other reproduction of all or parts 
of this document is prohibited without the permission of Savant Systems.

Trademarks
© 2022 Savant Systems, Inc. All rights reserved. Savant, Savant App, TrueImage, Savant Host, Now You Can, RacePoint Blueprint, Single App Home, 
TrueCommand, TrueControl, and the Savant logo are trademarks of Savant Systems, Inc.
AirPlay, Apple, AirPort Express, AirPort Extreme, Apple TV, Apple Remote Desktop, FireWire, iMac, iTunes, iPad, iPad mini, iPad Air, iPhone, MacBook, Mac 
and OS X are trademarks or trade names of Apple Inc. iOS is a trademark of Cisco®. Android, Google, Google Play, and other Google marks are trademarks 
of Google, Inc. Wi-Fi is a registered trademark of the Wi-Fi Alliance®. HDMI® is a trademark of HDMI Licensing, LLC. MOTU® is a registered trademark of 
Mark of the Unicorn, Inc. Luxul is a registered trademark of Luxul Wireless. NETGEAR®, the NETGEAR Logo and ProSAFE are trademarks of NETGEAR, Inc. 
Extreme™ is a trademark of Extreme Networks, Inc.
All other brand names, product names, and trademarks are the property of their respective owners.

Technical and Sales Support
Savant Systems, Inc is dedicated to providing prompt and effective support in a timely and efficient manner.
 – To contact Savant Support, access the Savant Customer Community and enter a support Case ticket.
 – To contact Savant Sales, visit Savant.com and select Contact Us to locate a local sales representative in your area.

https://community.savant.com/Customers/SavSupportLogin
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